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1.0  WHAT IS DICE 
 
1.1 Introduction 
 
A relational database containing information extracted from the International Criticality Safety 
Benchmark Evaluation Project (ICSBEP) Handbook has been developed with a user interface that 
allows interrogation of the database.  The database was first released with the 2001 Edition of the 
ICSBEP Handbook.  The database and the corresponding user interface are referred to as DICE 
(Database for the International Handbook of Evaluated Criticality Safety Benchmark Experiments).  
DICE is maintained and upgraded on a continual basis and released annually with the Handbook.  
DICE allows simple or complex queries or searches on specific data and parameters of experimental 
benchmarks within the ICSBEP Handbook.  A wide variety of searches can be performed, such as 
experiments performed at a specific facility or experiments matching select engineering parameters, 
e.g., the main components of a fuel-pin cell (type of fuel, cladding, moderator, and/or coolant).  
Additionally, global searches of all the experimental configurations containing any nuclide or isotope 
of interest can be performed using queries such as “Fuel region contains” and “Neutron Balance.” 
 
A very brief overview of DICE follows.  A more complete description of the content and how to 
perform queries is provided in the Glossary which supplements the User’s Manual.  It is a glossary 
containing all the terms used by DICE.1  It provides the definition of each term and indicates where in 
the ICSBEP Handbook the data are obtained.  This glossary is intended to assist the users of DICE not 
only with searches of the database but also with their interpretation of the parameters obtained by 
those searches.  Furthermore, the clarification of the terms used by DICE will also assist benchmark 
evaluators, who are now required to enter select benchmark data into an Excel spreadsheet from which 
it will be automatically entered in the DICE database. 
 
Refinements and additions in both the content and search capabilities of the DICE database are 
ongoing.  Therefore, both the DICE User’s Guide and the DICE Glossary will continue to undergo 
periodic revision.  Comments, corrections and suggestions are always welcome and can be forwarded 
to dice@oecd-nea.org. 
 
1.2 What’s new? 
 
The DICE 2010 edition database tool has been enhanced by the following features: 
 

• The “Fuel composition (isotope wt%)” now displays one column per isotope in the results 
tables instead of one row per isotope; 
 

• The HTML summary can now display a full evaluation; 
 

• The “Open Handbook PDF…” menu has been improved. It is now possible to open an 
evaluation PDF, the main evaluation PDF, the spectra PDF or the balance file directly. Short 
notation of identifiers is allowed e.g. type ‘pst33-1’ to open PU-SOL-THERM-033-001 
corresponding files; and 
 

• This manual can now be directly opened within DICE by pressing CTRL+F1 keys or by 
selecting “Help->User’s Manual” in the menu bar. 

 
The geometry structure or theme has been reorganized into two levels (Core and Fuel unit).  
 

                                          
1 The present version of the Glossary addresses only the terms contained in the Critical / Subcritical Search pane 
of DICE. 

mailto:dice@oecd-nea.org
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The database content has also been revised. In particular: 
 

• Spectra calculation results have been added; 
 

• Effort to verify data has been continued. 
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2.0  QUICK START 
 
In order to use the DICE tool and access the DICE database, you must: 
 

• Have the DVD containing DICE in order to run DICE directly from the DVD or add DICE to 
your computer as instructed below; 
 

• Have Java installed on your computer or add it as instructed below; 
 

• Have a large screen; a minimum resolution of 1024×768 is recommended. 
 
 

2.1 DICE 2010 DVD Contents 
 
The DVD contains the following directories and files for DICE installation and operation: 
 

• Root directory contains this user’s manual; 
 

• Directory “CD2010”: contains the ICSBEP Handbook; 
 

• Directory “Dice”: contains dice.bat and dice.sh batch command files; 
 

• Directory “Dice\data\balance”: contains neutron balance files; 
 

• Directory “Dice\data\newE”: contains energy group structure files; 
 

• Directory “Dice\data\ornl”: contains TSUNAMI-3D-K5 and TSUNAMI-3D-K6 sensitivity 
profiles and corresponding input files for KENO V.a and KENO VI; 
 

• Directory “Dice\data\sensitivity”: contains sensitivity files; 
 

• Directory “Dice\data\spectra”: contains spectra files; 
 

• Directory “Dice\databases”: contains the H2 local database; 
 

• Directory “Dice\java”: contains Java installation files for Windows and Linux; 
 

• Directory “Dice\software”: contains the DICE software. 
 

• Directory “Plugins”: contains DICE plugins (e.g. ORNL VIBE tool). 
 
 

2.2 DICE Installation (Optional) 
 
You can run DICE directly from the DVD or copy the entire “Dice” folder contents onto your hard 
drive.  This requires approximately 1.9 GB. 
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2.3 Java Installation 
 
If Java is already installed on your system, skip Section 2.3 and proceed to Section 2.4.  The DVD 
provides two executable files (directory “Dice\java”), one for Windows and one for Linux: 
 

• Double click on the file jre-6u15-windows-i586-s.exe to install the Java runtime on 
Windows; 

 
• Execute the file jre-6u7-linux-i586-rpm.bin to install the Java runtime on Linux. 

 
If you are not using Windows or Linux, Java runtimes for other operating systems can be obtained 
from Sun Microsystems’ websites http://www.java.com or http://java.sun.com. 
 
2.4 Launch DICE 
 
DICE can be launched by using the dice.bat (for Windows) or dice.sh (for Linux/UNIX) executable 
scripts available in the “Dice” folder. For Macintosh users, the folder mac_os_x contains a Mac OS X 
bundle.  
 
However, if you wish to use VIBE as a DICE plugin, use the executable scripts instead vibe-dice.bat 
(for Windows) or vibe-dice.sh (for Linux/UNIX). 
 
Once you launch DICE, a Disclaimer window will appear before the main DICE window appears. 
 
Note:  Plugins currently share the connection to the same “LocalShared” database. This database is 

the H2 database provided on the DVD which must be copied on a local hard drive (The 
database management system needs to create files to share the connection between DICE and 
any plugin). 

 

http://java.sun.com/
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3.0  GENERAL OVERVIEW 
 

The first screen of the user interface is the “Search” window, which is shown in Figure 1.   

 
The DICE main window is composed of four main panes: 
 
1. Critical / Subcritical: searches through all of the critical and/or subcritical experiment cases 

(Volumes I-VII) of the Handbook; 
 

2. Alarm / Shielding: searches through all of the alarm and/or shielding measurement cases (Volume 
VIII) of the Handbook; 
 

3. Fundamental Physics: searches through all of the fundamental physics measurement cases 
(Volume IX) of the Handbook; 
 

4. Correlation Matrix: displays correlation coefficients for criticality evaluations. 
 

As noted, only terms in the Critical / Subcritical pane are presently discussed in the Glossary. 

 
The “File” menu allows you to: 
 

• Export DICE results tables/plots into files; 
 

• Open a file from the ICSBEP Handbook (evaluation PDF, spectra PDF or balance file); 
 

• Open the Settings dialog; 
 

• Check if an update is available (requires an Internet connection); 
 

• Exit the software. 
 

The “Database” menu allows you to switch databases: 
 

• “Local”: the local database provided on the DVD; 
 

• “LocalShared”: the local database, ready to be shared with DICE plugins; 
 

• “NEA”: the NEA master database that can be updated after the DVD has been released. 
 

The database menu is dynamically updated to display the selected database name. 
 
Note:  To successfully update DICE, DICE needs to be copied on a local folder in order to create 

new files containing updates. 
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3.1 Critical / Subcritical Pane 
 

 
 

Figure 1. Critical / Subcritical Pane. 
 
 
This pane provides you with various data and/or parameter search criteria (e.g. fissile material, 
evaluator, geometry, etc.) allowing you to search for specific critical and/or subcritical cases in regards 
to your search criteria (Volumes I,II,III,IV,V,VI and VII of the ICSBEP Handbook).  The search 
criteria is explained in detail in the Glossary. 
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3.2 Alarm / Shielding Pane 
 

 
 

Figure 2. Alarm / Shielding Pane. 
 
 

This pane provides you with various data and/or parameter search criteria (e.g. source, evaluator, 
detector type, etc.) allowing you to search for specific alarm and/or shielding cases in regards to your 
search criteria (Volume VIII of the ICSBEP Handbook). (As noted, only terms in the Critical / 
Subcritical pane are presently discussed in the Glossary.) 
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3.3 Fundamental Physics Pane 
 

 
 

Figure 3. Fundamental Physics Pane. 
 
 

This pane provides you with various data and/or parameter search criteria (e.g. source, evaluator, 
detector type, etc.) allowing you to search for fundamental physics cases in regards to your search 
criteria (Volume IX of the ICSBEP Handbook). (As noted, only terms in the Critical / Subcritical pane 
are presently discussed in the Glossary.) 
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3.4 Correlation Matrix Pane 
 

 
 

Figure 4. Correlation Matrix Pane. 
 
 
This pane provides you with data indicating whether two criticality cases are correlated and to which 
degree (coefficient between 0.0 and 1.0) once that information is available.  
 
Note:   Only limited correlation coefficient data are currently available.  These data were derived 

from IPPE. 
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3.5 Customizing DICE 
 

 
 

Figure 5. Settings Dialog. 
 
 
Once the DICE DVD is inserted or DICE is available on your computer, Java is installed and 
available, and DICE is launched, you may be required to customize DICE to operate properly on your 
computer.  This can be done by opening the Settings dialog by selecting the menu “File->Settings…”. 
This dialog allows you to set: 
 

• The ICSBEP Handbook folder location; 
 

• The PDF viewer executable file to use; 
 

• The HTML viewer executable file to use; 
 

• The location of the folders for balance, spectra, and sensitivity data files; 
 

• HTTP Proxy information (host, port, and credentials).  You must restart DICE for this setting 
to take effect. 
 

Note:  If you run DICE on Microsoft Windows, the PDF and HTML viewer settings should not need 
to be set. When these settings are left empty, DICE will launch the default PDF and HTML 
viewers if they are already installed. 

 
Note:  DICE settings are stored in a plain text file located under your personal documents folder 

(%USERPROFILE% under Windows) named dice_2_0_settings.txt. To reset the settings to 
the default values, you can delete this file while DICE is not running. 
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3.6 About DICE Dialog 
 

 
 

Figure 6. About DICE dialog. 
 
 
If you would like to view this information, open the About DICE dialog by selecting the menu “Help-
>About DICE”. 
 
This dialog shows summary information about the DICE version, Java version, operating system, and 
network settings that you are currently using.  This information should be transmitted to the DICE 
developers if you report a problem or submit an enhancement request (use the “Copy messages” 
button to copy this information to the clipboard).  To contact DICE developers directly, send an e-mail 
to dice@oecd-nea.org. 
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4.0  SEARCHING 
 
DICE allows you to search the Handbook for particular evaluations. The three panes “Critical / 
Subcritical”, “Alarm / Shielding” and “Fundamental Physics” work the same way. 
 
4.1 Setting Search Criterion 
 
The list or tree in the far left side of the main window presents the available search criteria grouped 
into “Themes.”  The right panel(s) of the window displays the selected theme control panel(s).  The 
four main types of search criterion are described below. 
 
4.1.1 Selection List 
 

 
 

Figure 7. Selection List criterion. 
 
 
Select one or more items from the list.  
 
Note:  You can use the CTRL and SHIFT keys to select multiple items. 
 
The first item “None selected” can be used to unselect all highlighted items. 
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Some theme criteria can have multiple values for a given ICSBEP evaluation or cases within an 
evaluation (e.g. moderator material).  In these instances, you can search evaluations by selecting: 
 

• Any of your choices with the “OR” button; 
 

• Or all of your choices together with the “AND” button. 
 

These two buttons remain grayed-out until you select more than one item from the list (“OR” is the 
default). 
 
For example, by selecting “Lucite” and “Water (Light Water)” in the moderator/coolant materials list 
and leaving the default “OR” button, you will find the ICSBEP evaluation cases having “Lucite” or 
“Water (Light Water)” or both as moderator/coolant material.  If you select the “AND” button, you 
will only find those evaluation cases that have “Lucite” and “Water (Light Water)”. 
 
4.1.2 Numerical Values 
 

 
 

Figure 8. Numerical Values criterion. 
 
 
You can search for numerical values in two ways: 
 

• For a specific value with an optional accuracy, the accuracy has to be input as a percentage of 
the specified value (e.g. “75” with an accuracy of “10” would search for values between 68.5 
and 82.5). 
 

• For a range of values, specify a minimum and/or a maximum value. If you specify an upper 
value that is less than the current value, the criterion is not set. 
 

You can enter a numeric value in scientific notation (e.g. 1E3 means 1000). 
 
Note:  If a numeric value is invalid, it is displayed in white on a red background (e.g. you cannot add 

a percent sign [%] in the accuracy field). 
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4.1.3 Text Fields 
 

 
 

Figure 9. Text criterion. 
 
 
Text searches may be performed by selecting “Title”, “Keyword”, or “Reference” under the General 
Items tree structure. Keyword searches are limited to the list of Keywords provided in each ICSBEP 
evaluation report.  To search on text, first choose the operator in the drop-down: 
 

• Contains; 
 

• Does not contain; 
 

• Begins; 
 

• Does not begin; 
 

• Ends; 
 

• Does not end; 
 

• Equals; 
 

• Does not equal. 
 

Then, enter a word or part of a sentence in the text field. This criterion also supports a wildcard 
character (‘%’). 
 
If you wish to perform a case sensitive search, check the “case sensitive” box. 
 
Note:  You can search for Unicode characters as they appear in titles and references (e.g. some 

Russian references are spelled in Cyrillic in the database). 
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4.1.4 Hierarchical Field 
 

 
 

Figure 10. Hierarchical criterion. 
 
 
You can select one or more items from the selection lists within a tree. 
 
Selecting a parent node of a tree is equivalent to selecting all of its children nodes within a tree (e.g. by 
selecting “France” in the Laboratory tree, the database searches for all experiments performed in 
“Cadarache”, “Saclay” or “Valduc”). 
 
4.2 Query Panel 
 

 
 

Figure 11. Query Panel. 
 
 
The query pane located at the bottom of the screen displays the criteria currently set and the columns 
selected in the results window. 
 
You can remove a criterion by selecting it and pressing the “Del” key.  The “Clear” button removes all 
selected criteria. 
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You can remove a checked results columns directly from this window by selecting it and pressing the 
“Del” key. 
 
Each time you add, change, or remove a criterion, the status bar is updated to display the number of 
evaluations and cases found in the database matching the current selected criteria. 
 
Once the search criteria have been selected, run the query by clicking the “Search !” button. This will 
display the “Results” view. 
 
Note:  The “History” drop down list displays the 10 most recent executed DICE queries. To recall a 

previous query, select it from the list and all search criteria will be automatically set to match 
the previous search. 
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5.0 DISPLAYING RESULTS 
 

 
 

Figure 12. Results Window. 
 
 
Several views are available for displaying search results [You can switch between the four views by 
using the toolbar buttons (1 in Figure 12)]: 
 

• Flat table; 
 

• Hierarchical tables (horizontal or vertical split); 
 

• Plot. 
 

Use the left tree to select the result tables/plots columns (2 in Figure 12). After making changes, press 
the “Apply” button (3 in Figure 12) to refresh the result views. The “Apply” button is enabled 
whenever a new result column is added/removed. Selected result columns are displayed in bold. 
 
To return to the main search window, click on the “Return to search” button (4 in Figure 12). 
 
In order to enlarge the space available for the result views you can hide this tree by clicking on the 
“Select columns” button. 
 
Note:  You cannot uncheck the Identification column.  A computed column (# cases) that displays 

the number of cases matching the query is automatically added. 
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5.1 Results Tables 
 
To sort data, click on the desired column’s header. To reverse the sort order, press the SHIFT key 
while clicking on the desired column header. 
 
You can remove row(s) from the tables by selecting them and pressing the DEL key or by right-
clicking the mouse to display the contextual menu and then selecting “Remove selected row(s)”. To 
restore the initial search results, press the “Apply” button.  
 
You can copy selected row(s) from the results tables and paste them into your text editor or Microsoft 
Excel. 
 
You can reorder the results tables’ columns. To do so, click on a column header and drag the mouse to 
the desired location. 
 
5.1.1 Hierarchical Results Tables, Horizontal Split 
 
This view is made of two tables separated by a vertical bar. In the left pane, the evaluation level 
columns are shown. In the right pane, the case level columns are shown. 
 
The right table (case level) displays the cases for the selected evaluations in the left table or all of the 
cases if none are selected. 
 
5.1.2 Hierarchical Results Tables, Vertical Split 
 
This view is the same as hierarchical results tables, horizontal split, except the tables are split by a 
horizontal bar. 
 
5.1.3 Single Result Table, Flat View 
 
In this mode, all columns are displayed in a single table. 
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5.2 Results Plot View 
 

 
 

Figure 13. Results Plot View. 
 
 
In order to plot certain data, you can select “X axis”, “Y axis” and “Series” among the selected results 
columns (see Section 5.0).  At least one numerical column needs to be available in order to obtain 
plots. The text columns (e.g. “References”) cannot be used in plots but all others can, except for the 
“Y axis”, which requires a numerical column (e.g. “Number of cases”).  For example, you can plot 
“Calculated Keff” (Y axis) against “Fuel concentration” (a numerical column) but also against 
“Library” or “Codename” (short text columns). 
 
By right-clicking on the plot, a contextual menu allows you to: 
 

• Set some plot properties (title, legend, ticks); 
 

• Save the plot in a file; 
 

• Print the plot; 
 

• Zoom in or out. 
 

You can also use the mouse to zoom in by pressing the left button and then dragging the mouse from 
the top-left to the bottom-right corner.  To reset the zoom level, drag the mouse from the bottom-right 
to the top-left. 
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To display the data values corresponding to each point, hover the cursor over it to display a tooltip 
showing its coordinates. 
 
Note:  The legend is not displayed when there are more than 20 items to show. Press the “Select 

columns” button to enlarge the plot window. 
 
5.3 Evaluation PDF from the Handbook 
 
After having selected a single evaluation level row, press the “PDF” button in any results table view to 
open the PDF file containing the evaluation from the Handbook (5 in Figure 12).  
When an evaluation is part of a cross-references group, the user has the possibility to directly open the 
main evaluation PDF file. 
 
Note:  If the selected evaluation does not open, DICE was probably not able to find your default 

PDF reader, and you need to specify its location in the Settings dialog (see Section 3.5). 
 
5.4 Evaluation/Case Summary in HTML 
 
After having selected a single evaluation or a single case in any of the results tables, press the 
“HTML” button (5 in Figure 12) to open an HTML file displaying a summary of either the selected 
evaluation or the selected case. 
 
Note:  If a browser does not open, DICE was probably not able to find your default browser, and you 

need to specify its location in the Settings dialog (see Section 3.5). 
 
5.5 Neutron Balance File 
 
After having selected a single case in any of the results tables, press the “Balance” button (5 in Figure 
12) to open the corresponding neutron balance file. 
 
Note:  If the balance file cannot be found, check the location of the “Balance folder” specified in the 

Settings dialog (see Section 3.5).  
 
Note:  Neutron balance data are currently available for only about 82% of the available 

configurations in the ICSBEP Handbook. 
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5.6 Spectra and Sensitivity Plots 
 

 
 

Figure 14. Sensitivity Plot. 
 
 
DICE can plot spectra and sensitivity data for criticality cases.  Click on the “Spectra plots” or 
“Sensitivity plots” buttons. 
 
Select the dataset(s) in the tree on the lower right pane (1 in Figure 14). 
 
Then, select the representation (2 in Figure 14): 
 

• Group averaged/Group integrated; 
 

• Normalization: to one or the entire reaction rate; 
 

• Energy Group structure: select one structure from the drop-down list, press the “…” button to 
add an energy file to this list (3 in Figure 14). 
 

All data share the same representation.  When you change the energy group structure, all plots and the 
table are automatically updated. 
 
To zoom in, drag the mouse from the top-left corner to the bottom-right corner.  To reset the plot to its 
initial zoom level, drag the mouse from the bottom-right corner to the top-left corner. 
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You can switch between the plots and a tabular display by using the buttons “Plots” and “Table” (4 in 
Figure 14). 
 
Click on the “Clear” button to remove all plots and empty the table (5 in Figure 14).   
 
Click on the “Load own data…” button to add a curve from a file (6 in Figure 14).  
 
A sensitivity file must be in any of the following formats in order to plot: 
 

• ABBN sensitivity format; 
 

• TSUNAMI1D; 
 

• TSUNAMI3D. 
 

Check the corresponding button in the Open file dialog before pressing the OK button. 
 
Note:  Spectra data are currently available for only about 82% of the available configurations in the 

ICSBEP Handbook. 
 
Note:  IPPE sensitivity data are currently available for only 7% of the available configurations in the 

ICSBEP Handbook (in Volumes I and II). 
 
Note:  ORNL sensitivity data are currently available for only 8% of the available configurations in 

the ICSBEP Handbook (mainly in Volumes V and VI). 
 
5.7 Exporting Results 
 
5.7.1 Clipboard 
 
The DICE results tables can be copied to the clipboard by using the CTRL-C or CTRL-INS keys.  
Results can be pasted into Microsoft Word (as a formatted table) or Excel (as table cells) or any other 
text editor or spreadsheet program. 
 
5.7.2 Files 
 
The menu “File->Save As…” can be used to save tables or plots. 
 
Tables can be saved as “tab delimited” (convenient for Microsoft Excel or any other spreadsheet 
program) or “Comma Separated Values” (CSV) files. 
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Use the export dialog to set the delimiter: 
 

• Tab; 
 

• Semicolon; 
 

• Comma; 
 

• Other (type a delimiter in the box below). 
 

Then set the encoding: 
 

• ASCII (non-ASCII characters will be converted, e.g. ‘δ’ will be converted into ‘delta’); 
 

• Unicode (no conversion of characters). 
 

Plots can be exported as Portable Network Graphics (PNG) files. 
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6.0 CORRELATION MATRIX WINDOW 
 

 
 

Figure 15. Correlation Matrix Window. 
 
 
The correlation matrix window is split into two panes. The left pane allows you to narrow the display 
by evaluation IDs or by nuclear facilities. The right pane displays the correlation matrix. 
 
You can display certain parts of the correlation matrix by filtering on the following criteria: 
 

• Evaluation identification: the three drop-down menus on the upper left (1 in Figure 15); 
 

• Country/facility by using the tree (2 in Figure 15); 
 

• Self-correlations: check or uncheck the “Show self-correlation” check box. 
 

At the evaluation level, the matrix cells will have the following attributes: 
 

• Empty when there is no correlation; 
 

• A “+” sign to indicate correlation; 
 

• A “(+)” symbol to indicate a 100% correlation; 
 

• Teal when there are case level data available, or bright blue otherwise. 
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Note:  The “(+)” symbol appears when an evaluation has many identifiers in the ICSBEP Handbook 

(i.e. is a cross reference). 
 

At the case level, the matrix cells may be: 
 

• Empty when there is no correlation or the correlation coefficient is not known; 
 

• Colored with shades of green, brighter green being closer to 1. 
 

To switch between evaluation and case levels click the “Show cases level details” at the top of the 
matrix window and “Return to evaluations level” buttons (3 in Figure 15). 
 
When no correlation coefficients (cases level) are available in the database, the message “Sorry, no 
case/case correlation coefficients available...” is displayed. 
 
Note:  You can select multiple cells by holding the CTRL key while selecting cells or dragging the 

mouse to select a sub block from the matrix. 
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7.0  PLUGINS 
 

 

Figure 16: VIBE Pane 
 
7.1  Introduction 
 
DICE has been updated to enable the integration of third party tools (plugins) into DICE. Each plugin 
is displayed in its own tab allowing users access to the plugin functionality without exiting DICE or 
launching both tools. 
 
As plugins are available, they will be added to DICE. 
 
7.2  VIBE 
 
VIBE is a new graphical user interface created to identify and interpret sensitivity data from 
SCALE/TSUNAMI that is distributed with SCALE 6.0. It enables users to: 
 

• Group collapse sensitivity data; 
 

• sort and filter the collapsed data so as to identify important processes in applications or 
experiments; 
 

• Provide an improved means of preselecting experiments for use in criticality code validation.  
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VIBE also enables users to query the DICE database to gain more information about experiments 
present in the database.  VIBE also supports other sensitivity data distributed with the 2010 release of 
the ICSBEP Handbook.  
 
To use VIBE as a DICE plugin, please use the vibe-dice.bat batch file on Windows or the vibe-dice.sh 
script file on UNIX/Linux. 
 
To access VIBE, select the VIBE tab. When the VIBE tab is selected, the “VIBE” menu located in the 
top menu bar is enabled. From then on, you can use VIBE in DICE. 
 
Note:  To remove the plugin, use the dice.bat/dice.sh batch files to launch DICE. 
 
For the time being, the VIBE plugin can only access the “LocalShared” database when copied on a 
local hard drive, or the “Local” database when DICE runs directly on the DVD. 
 
Note: Plugin instructions are not provided in this manual. 
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8.0 TROUBLESHOOTING 
 
8.1 Known Problem(s) 
 
This table lists all known problems and their solutions: 
 

Problem description Solution 

Figures are displayed with a comma 
instead of a dot as the decimal 
separator or vice versa 

You can override your language settings to American-English by 
adding the following command line options to the dice.bat or dice.sh 
file: 

-Duser.language=en -Duser.country=us 

Refer to java.sun.com/developer/technicalArticles/J2SE/locale/ for 
technical details. 

DICE results tables contains strange 
characters (e.g. square boxes or 
question marks) 

This problem can stem from missing fonts. Try the following: 

On Microsoft Windows, select Add/Remove programs in the Control 
Panel. Be sure that the optional feature “Additional Fonts and Media 
Support” is installed on the local hard drive. To check that all fonts 
are installed, browse your Java home directory and the lib\fonts 
subdirectory. 

VIBE tab does not appear although I 
have VIBE correctly installed on my 
system 

Make sure you have used the dice_vibe.bat file to launch DICE (See 
Section 7). 

 
 

8.2 Startup Problem(s) 
 
DICE cannot start if it cannot connect to any database.  If this occurs, you will obtain the following 
dialog: 
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Figure 17. No Connection Dialog. 
 
 
If you are trying to connect to the NEA master database (see Section 3.0), first check if the NEA 
website is currently accessible (www.oecd-nea.org).  If you need to connect through an HTTP proxy, 
click on the “Setup HTTP proxy…” button to open the Settings dialog.  Restart DICE for the settings 
to take effect. 
 
If you are trying to connect to a local database (see Section 3.0), check that the data files exist on the 
media (DVD or computer) and that you have read access. 
 
If you still cannot connect to either master database, please send an email message containing the error 
messages to dice@oecd-nea.org.  You can copy these messages to the clipboard by using the “Copy 
messages” button. 
 
8.2.1 Windows 
 
To track down start up problems on Windows, follow these instructions:  
 
1. Determine if you have a suitable Java environment.  
 
2. Open a command window (Start menu > Run…) then type cmd.  
 
3. In the Command Prompt window, issue the java –version command.  
 
4. If you see the following message, your computer does not have Java properly installed: 
 

C:\>java -version  
'java' is not recognized as an internal or external command, 
operable program or batch file.  

 

http://www.oecd-nea.org/
mailto:dice@oecd-nea.org
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If this is the case, check that the PATH environment variable is correctly set.  Alternatively, Sun 
Microsystems offers a web page to verify your Java installation at 
www.java.com/en/download/installed.jsp.  
 
You can download Java from java.sun.com or alternatively install it from the DVD in the Dice\java 
folder.  (You should use a JRE 1.5 version at a minimum).  Once this is done, go to the DICE\software 
folder and type the following command:  
 
java –jar Dice.jar  

 
DICE should now open.  If not, to request further help, if there are error messages in the console, 
right-click in the title bar, choose menu “Select all”, then “Copy”, and send the text in the clipboard to 
the DICE developers (dice@oecd-nea.org) for assistance. 
 
8.2.2 Linux/UNIX 
 
To troubleshoot problems on Linux, follow the below instructions:  
 
First, make sure your Java installation is correct with the following command:  
 
java –version 

 
You may need to put the full path to your Java executable in the dice.sh script and make sure that it 
has execution rights. 
 
8.3 Speed Problem(s) 
 
The following tips will improve execution speed: 
 

• Copy the DVD onto your hard drive instead of running from the DVD drive 
 

• Connect to the NEA remote database 
 

• Narrow the search to a few evaluations before pressing the “Search !” button 
 

• Display only relevant columns in result views. 
 

8.4 Memory Problem(s) 
 
Java programs need to specify the maximum memory they can use.  With a Sun Microsystems Java 
Machine this setting must be set by command line (or in the BAT or SH file).  The memory limit used 
by DICE is set in the dice.bat file (or dice.sh for Linux): 
 
-Xmx256M 

 
The above option –Xmx256M specifies that DICE will take at most 256Mbytes of memory.  If you 
have more physical memory (e.g. 512MB, 1GB, or more), you can edit this command line and replace 
the option –Xmx256M with –Xmx512M.  For example to allow DICE to use at most 512MB of 
memory the dice.bat file should be: 
 
-javaw -Xmx512M -jar Dice.jar 

 

mailto:dice@oecd-nea.org
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8.5 Bug Report Dialog 
 

 
 

Figure 18. Bug Report Dialog. 
 
 
The “Bug report” dialog is shown when a problem occurs in the DICE software.  This dialog contains 
useful information for developers and allows you to send an automatic report to them. 
 
Clicking the button “Send bug report” will bring up a dialog allowing you to enter your name, email 
address, and explanatory text. 
 
Filling in these fields are optional but consider inputting your email address so that you can receive an 
answer.  
 
Note:  Your email address will not be used for any other purpose. 
 
The Bug report functionality can only detect a programming bug (i.e. misuse of software API).  
 
To submit a manual bug report or a software enhancement request, please send an e-mail to 
dice@oecd-nea.org.  Please include the following information: 
 

• Screen captures; 
 

• Your environment (Operating System and Java version); 
 

• DICE version. 
 

This information can be found in the “About” dialog (see Section 3.6). 
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9.0 A GLOSSARY OF DICE TERMS FOR CRITICAL AND SUBCRITICAL 
MEASUREMENTS 

 
The user selects from a set of search criteria given in the search window to query the DICE database.  
As shown in Figure 1, the search parameters are grouped into 11 themes: 
 

• General items 
 

• Fuel 
 

• Moderator / coolant material 
 

• Cladding material 
 

• Reflector material 
 

• Neutron absorbing material 
 

• Separation material 
 

• Geometry 
 

• Energy and spectra 
 

• Benchmark keff and uncertainty 
 

• Calculations 
 

The outcome or result of submitting a query is displayed in the “Result” window.  It may be noted that 
this window now includes an additional theme:  Fuel region composition, which has been inserted 
after the “Geometry” and before the “Energy and spectra” themes. 
 
Generally, items selected in the Search window, i.e., the search parameters, are then displayed in the 
Result window.  That is, in general the terms or parameters presented in the Search window can (and 
will) be displayed in both the Search and the Result windows.  However, there are some terms or 
parameters which, though not part of the search parameters, can be requested (displayed) in the result 
window and therefore appear only in the result window.  Good examples of this type of parameter 
include the items in the “Fuel area composition” theme, which are displayed only on the Result 
window.  Additionally there exist only a very few unique cases where parameters specified in the 
Search window are not displayed in the Result window.  Therefore, it can be assumed by the reader 
that all of the following terms in the glossary appear in both the Search and the Result windows, 
except where explicitly noted to appear in only the Search window or only the Result window. 
The glossary items are now discussed below in the same order as the 12 themes shown in the Result 
window (Figure 1 and Figure 19). 
 
Unless otherwise specified, for recent evaluations (written after 2008) the data were entered into DICE 
by copying information from an Excel spreadsheet provided by the evaluator(s).  For earlier 
evaluations, all the data were extracted from the Handbook and entered manually.  The data 
correspond to the benchmark models of experimental configurations described in Section 3, which can 
be different from the description of experimental configurations presented in Section 1. 
Parameters followed by an asterisk are displayed only in the Result window. 
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Figure 19. Partial View of the Result Window. 
 
9.1 General Items 

 
The data or parameters in this theme or group are provided for all evaluations. 
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Identification 
 
A unique identifier for each benchmark evaluation that takes the form: 
 
Fissile Material – Physical Form – Spectrum – Three-Digit Numerical Identifier 
such as PU-MET-FAST-003 for fast, plutonium system in which the fissile material is in the 
form of a metal.  In the case of subcritical experiments, the above identifier string is preceded 
by ‘SUB-’, such as SUB-PU-MET-FAST-001 for subcritical measurements of metal 
plutonium systems with fast spectrum.  This identifier is documented at the top of each page 
of the evaluation.  On the Search page this parameter may be set to “Critical,” “Subcritical,” or 
“Critical and Subcritical.” 
 
The subdivision into fast, intermediate, thermal, and mixed spectra systems depends upon the 
neutron energy range where the majority of the fissions occur.  In the Handbook, fast, 
intermediate, and thermal systems are defined as systems in which more than 50% of the 
fissions occur at energies > 100 keV, 0.625 eV - 100 keV, and < 0.625eV, respectively.  
Systems for which more than 50% of the fissions do not occur in any one of these three energy 
ranges are classified as “mixed” spectra systems.  Cross references are included in the 
ICSBEP Handbook and in DICE for experimental series containing data that may be 
categorized by more than one energy range.  For example, series MIX-MISC-FAST-001 is 
comprised of 11 experiments of which only three configurations (Cases 9, 10, and 11) are 
appropriately categorized as MIX-MISC-FAST systems.  The other configurations are 
categorized differently and presented in DICE under the identifiers shown in Table 1. 

 
Table 1.  Example of cross reference identifiers for configurations published in 

the Handbook under identifier MIX-MISC-FAST-001. 
 

Case # Identifier in DICE 
1, 2, 3 IEU-MET-FAST-017-001, -002, -003 
4, 5, 6 IEU-COMP-INTER-002-004, -005, -006 
7, 8 MIX-MET-FAST-015-007, -008 
9, 10, 11 MIX-MISC-FAST-001-009, -010, -011 

 
 
Acceptable/Not Acceptable 
 
Parameter indicating whether the evaluation of an experiment was determined by the ICSBEP 
to be acceptable (or not) for use as a critical or subcritical benchmark experiment.  That 
judgment is documented in Sections 1.1 and 2 of an evaluation.  Additionally, the total 
number of acceptable and not acceptable cases (indicated by “Number of cases”) for each 
evaluation is displayed (only) in the Results window.  For unacceptable configurations, data 
are provided only in theme “General Items.” 
 
Evaluator/Internal/Independent Reviewer 
 
Names of evaluator(s) and internal and independent reviewer(s) as documented on the Title 
Page of each evaluation.  Additionally, the country with which they are associated is indicated 
for each evaluator and/or reviewer. 
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Varying parameter(s) across cases 
 
Parameters of the experimental configurations that are varied for the cases within the 
evaluation to study the impact of the variation on criticality.  These are often identified in 
Section 1.1 of each evaluation. 
 
The varying parameters are:  absorber material, absorber material thickness, acid molarity, 
array configuration, array size (number of units), assembly configuration, fuel composition, 
fuel concentration, geometry, interstitial material, lattice pitch, mass of individual units, 
moderation degree, moderation level, not applicable (single case), position of rods, reflector 
location, reflector material, replacement material, separating material thickness, separation 
material, size of units, solution height, and temperature. 
 
Laboratory 
 
Laboratory or organization where the experiment or series of experiments was performed (as 
documented in Section 1.1).  In the Search window these are arranged by country, then 
laboratory or organization. 
 
Main Purpose 
 
Main purpose for performance of the experiment by the laboratory or organization.  This is 
often discussed in Section 1.1. 
 
The main purposes are: burnup credit, dry fuel storage, fuel fabrication, interaction, MOX 
applications, physics measurements, reflector test, reprocessing, solution storage, 
transportation and storage, waste matrix, and wet fuel storage. 
 
Title 
 
Title of the evaluation.  The title is given on the Title Page and repeated on the first page of 
the evaluation. 
 
Keywords 
 
A list of words that describe the evaluation as provided on the first page of the evaluation 
(e.g., acceptable, fuel type, geometry, moderation material, reflection material, unacceptable, 
etc.). 
 
Dates (evaluation and experiment) 
 
The year(s) when the experiment or series of experiments was performed (as documented in 
Section 1.1) as well as the most recent year when the evaluation was revised (if it has been 
revised) and approved (as documented in the footer of each page).  For the year(s) when the 
experiment or series of experiments was performed, a start date and end date are provided for 
each evaluation. 
 
Revision* 
 
The revision number of the evaluation (as documented in the footer of each page).  If the 
current evaluation is the original, this is indicated by a revision number zero. 
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References 
 
A list of formally published documents that contain relevant information about the 
experiment.  These are provided in Section 5. 
 
Number of cases* 
 
Total number of evaluated configurations within a series including the configurations rejected 
by the ICSBEP (as documented in Sections 1.1 and 2). 
 
# of cases* 
 
Total number of acceptable configurations within a series that match the search criteria. 
 
Label* 
 
Identifying name/number of the experiment used in the evaluation, as indicated in the 
reference documents. 
 
Case Number* 
 
The sequential number of the configurations that are considered as acceptable benchmarks by 
the ICSBEP.  The case numbers may appear in Sections 1 and 2, but will always be identified 
clearly in Sections 3 and 4 of the evaluation. 

 
9.2 Fuel 

 
Fuel may be characterized by Fuel form/Fissile material, Fuel region, U and Pu weight percent, and/or 
Pu/(U+Pu) ratio.  Each is described below. 

 
Fuel form/Fissile material 
 
The data or parameters in this group are common to all the experiments. 
 
The chemical form of the fuel in the evaluation (i.e., compound, metal/alloy, and/or solution).  
A list of fissile materials is given for each fuel form.  (The list of fissile materials provides 
information on the fissile nuclides or isotopes and their chemical form and gives more detail 
than the Fissile material used in the Identification). 
 
Fuel concentration (g/l)* 
 
Concentration of fissile material for homogeneous-fueled solution experiments.  This entry is 
left blank for experimental configurations other than solutions. 
 
Fuel region 
 
List of isotopes contained in the fuel region, irrespective of their effect on reactivity of the 
benchmark model.  Note:  this list appears only in the Search window.  Isotopes selected in the 
fuel region can be used to filter the set of experiments obtained in the search, i.e., experiments 
appearing in the Result window. 
 

http://en.wikipedia.org/wiki/Solution
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Fuel composition (wt%)* 
 
List of each isotope within the fuel and the corresponding weight percent. 
 
U and Pu weight percent 
 
Weight percents of the U and Pu isotopes.  Note:  this list appears only in the Search window.  
Ranges of isotopic fractions in the fuel region can be specified and used to filter the set of 
experiments obtained in the search, i.e., experiments appearing in the Result window. 
 
Pu/(U+Pu) ratio 
 
Ratio of the sum of the atom-densities of the Pu isotopes to the sum of the atom-densities of 
the U and Pu isotopes.  This ratio is listed as “0” for cases where U is present without Pu and 
as “1” for cases where only Pu is present. 
 
The data for “Fuel region,” “Fuel composition,” “U and Pu atom percent,” and “Pu/(U+Pu) 
ratio” automatically generated using homogenized core atom-densities provided in balance 
files or fuel material atom-densities provided in Section 3.3. 
 

9.3  Moderator/Coolant 
 

The data or parameters in the below groups are provided for most moderated and/or cooled 
experiments within an evaluation and are periodically updated.  These values are provided in 
Section 3. 

 
Moderator/Coolant material 
 
Moderator – a material present in the system to reduce the energy of the neutrons. 
Coolant – a material in an assembly or reactor mock-up that represents/simulates a reactor 
coolant. 
“None” indicates that neither moderator nor coolant materials are present. 
 
The moderator/coolant materials are:  alcohol, beryllium, beryllium oxide, cellulose acetate 
plastic, graphite, lead, lithium, Lucite/Plexiglas, mercury, oil, paraffin, polyethylene, 
polystyrene, sodium, Teflon, uranium hydride, water (heavy water), water (light water), and 
zirconium hydride. 
 
Vmod/Vfuel ratio* 
 
The Vmod/Vfuel ratio is limited to heterogeneous systems with fuel rod assemblies and plate 
type fuel. It refers to the ratio of moderator volume to fuel volume in the equivalent fuel cell 
(the volume of fuel clad is not included in either fuel or moderator).  If there is a hole in the 
fuel rod, its volume is excluded from the fuel volume. 
 
Moderator to fuel ratio* 
 
Moderator-to-fuel atom-density ratio refers to the ratio of moderator atom-densities to heavy 
metal atom-densities in the homogenized core.  This information is not currently available for 
some moderated experiments, but is being updated as balance files are calculated. 
 
These data are automatically generated using homogenized core atom-densities provided in 
balance files or atom-densities provided in Section 3.3. 

http://en.wikipedia.org/wiki/Fast_neutron
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Moderator to fissile ratio* 
 
Moderator-to-fissile atom-density ratio refers to the ratio of moderator atom-density to fissile-
isotopes atom-density in the homogenized core.  This information is not currently available for 
some moderated experiments, but is being updated as balance files are calculated. 
 
These data are automatically generated using homogenized core atom-densities provided in 
balance files or atom-densities provided in Section 3.3. 

 
The data or parameters in the groups below (i.e., “Cladding material,” “Reflector material,” “Neutron 
absorbing material,” “Concentration,” and “Separation material”) are provided for each experiment 
within an evaluation, as appropriate (as documented in Section 3). 

 
9.4 Cladding Material 

 
The specific material of the layer covering the basic fuel unit that prevents radioactive fission 
fragments or fuel particles from escaping the fuel.  When cladding material is not present in an 
experimental configuration, this is indicated by “None.” 
 
The cladding materials are: aluminum, carbon steel, hastelloy, lacquer, nickel, niobium, plastic tape, 
polyethylene, stainless steel, Teflon, zircaloy, and zirconium-niobium alloy. 

 
9.5 Reflector Material 

 
The material of the region surrounding the core whose purpose is to return a portion of leaking 
neutrons to the core by scattering.  When reflector material is not present in an experimental 
configuration, this is indicated by “None.” 
 

The reflector materials are:  
 
• Aluminum materials: Aluminum, Aluminum Oxide , Duralumin (Al, Fe, Cu)  
• Beryllium materials: Beryllium, Beryllium Oxide 
• Borated materials: Borated Concrete, Borated Uranyl Nitrate (B, U, N, H, O), Borated 

Light Water, Borated Polyethylene, Boron  
• Cadmium  
• Carbon materials: Borated Concrete, Borated Polyethylene, Carbon Steel, Concrete, 

Graphite, Lucite/Plexiglas (C, H, O), Molybdenum Carbide, Oil (C, H), Paraffin (C, H), 
Polyethylene, Tungsten Carbide  

• Cobalt  
• Copper materials: Copper, Duralumin (Al, Fe, Cu), Ni-Cu-Zn Alloy  
• Iron materials: Carbon Steel, Duralumin (Al, Fe, Cu), Iron, Stainless Steel (Fe, Cr, Ni)  
• Lead  
• Lithium Deuteride (Li, D, O)  
• Magnesium 
• Molybdenum materials: Molybdenum, Molybdenum Carbide  
• Nickel materials: Nickel, Ni-Cu-Zn Alloy  
• Poly materials: Borated Polyethylene, Polyethylene  
• Silicon Dioxide  
• Sodium 
• Steel materials: Carbon Steel, Stainless Steel (Fe, Cr, Ni)  
• Thorium  
• Titanium  



NEA/NSC/DOC(95)03/II 

DICE: User's Manual 

 

Revision:  3 Page 42 of 50 
Date:  September 30, 2010 

• Tungsten materials: Tungsten, Tungsten Carbide 
• Uranium materials: Borated Uranyl Nitrate (B, U, N, H, O), Depleted Uranium, Depleted 

Uranium Dioxide, Uranyl Nitrate, Highly Enriched Uranium, Natural Uranium, Uranium 
Dioxide 

• Vanadium  
• Water: Borated Light Water, Heavy Water (D, O), Lithium Deuteride (Li, D, O), Water  
 

9.6 Neutron Absorbing Material 
 

Neutron absorbing material with a large neutron absorption cross section, also called absorber or 
poison, which is inserted into the experimental configuration to study its effectiveness in lowering the 
reactivity of fuel and/or any material that lowers to a considerable degree the reactivity of the 
benchmark configuration, which are selected based on the percent of captures by isotope over core 
given in “Spectra” Section (Table 2).  Two lists of absorbing materials are provided:  solid absorbers 
in and soluble absorbers.  When neutron absorbing material is not present in an experimental 
configuration, this is indicated by “None.” 

 
The solid neutron absorbing materials are: 
 
• Aluminum materials: Aluminum ; Aluminum Oxide ; Boral (B, Al, Na, Si) 
• Borated materials:  Boraflex (B, CH2, Si) ; Boral (B, Al, Na, Si); Borated Concrete; 

Borated Glass (Pyrex) (B, Si); Borated Plaster (B, S, Ca, Fe); Borated Polyethylene; 
Borated Stainless Steel (B, Fe, Cr, Ni); Borax (B, Na); Boron; Boron Carbide (B4C); ZrB2 

• Cadmium 
• Copper 
• Depleted Uranium 
• Dysprosium Alloy (Dy, Ti) 
• Europium 
• Gadolinium Materials: Gadolinide Alloy (Gd, Ni, Cr, Mo), Gadolinium 
• Graphite 
• Hafnium 
• Iron 
• Lead 
• Poly materials:  Boraflex (B, CH2, Si), Borated Polyethylene, PVC (CH2, Cl), 

Polyethylene, Polystyrene (C, H) 
• Rhenium 
• Rhodium 
• Samarium 
• Silicon materials: Borated Glass (Pyrex) (B, Si), Silicon Dioxide 
• Steel:  Borated Stainless Steel (B, Fe, Cr, Ni), Carbon Steel, Stainless Steel (Fe, Cr, Ni) 
• Thorium 
• Vermiculite (H, C, N, O)  
• Zirconium materials :  Zircaloy (Zr, Fe, Sn, Cr), ZrB2 
 

http://en.wikipedia.org/wiki/Neutron_absorber
http://en.wikipedia.org/wiki/Cross_section_(physics)
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The soluble neutron absorbing materials are:  
 
• Boron 
• Cadmium 
• Fission Products2: Cesium, Europium, Rhodium, Samarium 
• Gadolinium 
 
Concentration (g/l)* 
 
Concentrations of soluble neutron absorbing materials are given and refer to the amount of 
absorber material in the solution. 

 
 

9.7 Separation Material 
 

Material that geometrically separates fuel units and/or fuel assemblies (see item below).  Typically, the 
materials are inserted into the experimental configuration specifically to study penetration of neutrons 
through them.  When separation material is not present in an experimental configuration, this is 
indicated by “None.” 

 
The separation materials are:  
 
• Air 
• Aluminum materials:  Aluminum, Boral (B, Al, Na, Si) 
• Beryllium materials:  Beryllium, Beryllium Oxide 
• Boron materials: Boraflex (B, CH2, Si), Boral (B, Al, Na, Si), Borated Concrete, Borated 

Glass (Pyrex) (B, Si), Borated Plastic Foam (B, C, H, O), Borated Polyethylene, Borated 
Stainless Steel (B, Fe, Cr, Ni), Foamglass (B, Si, Na, O) 

• Cadmium 
• Celotex (C, H, O) 
• Chromium 
• Concrete 
• Copper 
• Depleted Uranium 
• Gadolinium materials:  Gadolinide Alloy (Gd, Ni, Cr, Mo), Gadolinium 
• Graphite 
• Iron 
• Lead 
• Magnesium Oxide 
• Molybdenum 
• Nb-Zr 
• Nickel 
• None 
• Plywood (C, H, O) 
• Poly materials:  Borated Polyethylene, Polyethylene, Polystyrene (C, H) 
• Silicon Dioxide 
• Steel materials:  Borated Stainless Steel (B, Fe, Cr, Ni), Carbon Steel, Stainless Steel (Fe, 

Cr, Ni) 
• Tantalum 
• Titanium 

                                          
2 If Fission Products are involved in the experiment they are always entered as absorbers. 
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• Tungsten 
• Vanadium 
• Water (Light Water) 
• Zircaloy materials:  Nb-Zr , Zircaloy (Zr, Fe, Sn, Cr), Zirconium 
 
The absorbing separation materials are also entered as “Neutron absorbing material” (See 
Section 9.6). 
 

9.8 Geometry 
 

Major geometry details are given for benchmark configurations provided in Section 3. 
 
If several benchmark models are available in Section 3, the geometry details for simplified model are 
provided in DICE.  
 
The “Core geometry” and “Description for Complex/Mixed Geometry” are common to all the 
experiments within an evaluation. The data or search parameters “Fuel unit geometry,” “Number of 
fissile units,” “Pitch type,” and “Pitch size (cm)” are provided for each experiment within an 
evaluation unless not applicable to the experimental configuration.   

 
Core geometry 
 
Basic characteristics of the core geometry that indicates whether the core is simple or 
complex.  The core geometries are:   
 
• Array: Assemblies, Fuel Units  
• Infinite Media: Heterogeneous; Homogeneous  
• Single Fuel Unit. 
 
Fuel unit or Fuel unit geometry 
 
Geometry of the elementary fuel unit.  “Fuel unit” appears only as parameters to be selected 
on the Search window; “Fuel unit geometry” appears only on the Result window. 
 
The basic fuel units are: 
 
• Foil3 
• Intersecting Pipes 
• Micro-spheres (contained in): Spherical Pebbles 
• Mixed/Complex Geometries 
• Pellet 
• Plate(s)4:  Annular Plate(s), Curved Plate(s), Cylindrical Plate(s), Rectangular Plate(s) 
• Rod(s):  Annular Rod(s), Cylindrical Rod(s), Star Cross-Section Rod(s), 
• Solid Body (Shape):  Cuboid, Cylinder, Hemisphere, Hexagonal Block, Sphere, Annulus 
• Tank(s):  Annular Tank(s), Cylindrical Tank(s), Cylindrical Slab Tank(s), Nested Annular 

Tank(s), Nested Cylindrical Tank(s), Rectangular Tank(s), Rectangular Slab Tank(s), 
Spherical Tank(s) 

 
 

                                          
3 Metal in the form of very thin sheets. 
4 A thin, flat piece of tough material. 
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Fuel Unit Description 
 
Word description of fuel unit. This is provided for some configurations of Mixed/Complex 
Geometries. 
 
Pitch type 
 
Type of lattice geometry.  The information in this section is available only for configurations 
with Mixed/Complex Geometry and/or Rods as Fuel Unit Geometry. 
 
The pitch types are:  square and triangular. 
 
Pitch size (cm) 
 
Center-to-center distance of fuel units in the lattice.  The information in this section is 
available only for the configurations with Mixed/Complex Geometry and/or Rods as Fuel Unit 
Geometry. 
 
Number of fissile units 
 
Number of fuel units in an assembly.  The information in this section is available only if the 
core consists of assemblies or fuel units. 
 

 
9.9 Fuel Area Composition 

 
% Fissions* 
 
The percentage of fissions by isotope over the core region, as indicated in the corresponding 
Spectra file (see the “Spectra” link at the top of the first page of each evaluation). 
 
% Captures* 
 
The percentage of capture by isotope over the core region, as indicated in the corresponding 
Spectra file (see the “Spectra” link at the top of the first page of each evaluation). 

 
9.10 Energy and Spectra 

 
These data are 3-group and 30-group spectra and absorption data available in the ICSBEP Handbook 
(see the “Spectra” link at the top of the first page of each evaluation to see the corresponding Spectra 
file).  The details of calculations are reported in the section “Detailed Neutron Spectrum and 
Absorption Data (Criticality Alarm/ Shielding Benchmarks)” of the Handbook.  Spectra files are 
currently not available for some evaluations, but are being continuously added as the files are 
calculated. 

 
Energy of average neutron lethargy causing fission 
 
The energy corresponding to the average neutron lethargy causing fission, EALF (eV).  The 
average neutron lethargy causing fission is defined for group calculations by: 
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where m is the number of a physical zone inside the core; gu  is the midpoint of the gth 
lethargy group, defined as the lethargy of a neutron with energy Eg = EgEg−1 ;  is the 

group macroscopic fission cross section; and is the integral neutron flux in physical zone m 
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Average fission group energy 
 
The average neutron energy causing fission, AFGE (eV): 
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where Eg is the midpoint of the gth energy group, and other quantities are as previously 
defined. 
 
Flux distribution or Fission distribution or Capture distribution 
 
The percentage of the neutron flux, fissions, and captures, respectively, that occur in the fast 
(energy > 100keV), intermediate (0.625eV ≤ energy ≤ 100keV), and thermal  
(energy < 0.625eV) energy ranges. 
 
Neutron balance 
 
The percentage of fissions and captures by isotope over the core region.  This option to specify 
a range of fission- or capture-fractions by isotope in the query of experiments is provided only 
in the Search window. 
 
Neutron gas temperature 
 
The neutron gas temperature (Tn) is limited to configurations with a thermal neutron spectrum. 
For group calculations, Tn is defined as: 
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where σ g = σ 0
E0

E g
, T0 = 293.6 K, 0σ  is the cross section at E0 = 0.0253 eV (v = 2200 m/s, 

T = 293.6 K), and gφ  is the neutron flux in the groups collapsed into the thermal group 
(E < 0.625 eV).  Thus: 
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where E g = EgEg−1 . 
 
Average fission neutrons per neutron absorbed in the core 
 
The average number of fission neutrons produced per neutron absorbed in the core, (νΣf/Σa). 

 
9.11 Benchmark keff and Uncertainty 

 
If several benchmark models are available, the benchmark-model keff and uncertainty are usually 
provided for a simplified model. 

 
keff 
 
The benchmark-model keff (as documented in Section 3.5) is the expected value of keff from a 
calculation using the benchmark model and from the measurement for an experiment with 
materials and geometry exactly as described by the benchmark model (as documented in 
Section 3). 
 
 
keff uncertainty (1σ) 
 
The uncertainty of keff of the benchmark model (as documented in Section 3.5) is the 
uncertainty of the adjustment of keff due to simplification of the model (from Section 3.1) 
combined with the uncertainty of keff due to uncertainties in experimental data (from Section 2) 
to obtain the final combined uncertainty. 

 
9.12 Calculations 

 
Calculated keff and Calculated keff uncertainty 
 
keff and the uncertainty in keff calculated with various codes and cross-section data sets as 
tabulated in Section 4.  The results are obtained for the benchmark-model specification(s) 
provided in Section 3.  The specific code, cross section library, and benchmark-model label 
(as appropriate) are indicated for each calculation. 
 
If several benchmark models are available, the calculated keff and uncertainty can be provided 
for any of them and corresponds to calculation label (see definition below). 
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The specific code, cross section library, and calculation label (as appropriate) are indicated for 
each calculation. 
 
C/E* 
 
Ratio of calculated keff to benchmark keff for the various codes and cross-section data sets as 
tabulated in Section 4 C/E values are provided for the benchmark-model keff values entered 
into DICE and the corresponding calculated keff values. 
 
Code name* 
 
The specific code(s) used to calculate the benchmark-model keff and keff uncertainty.  This list 
includes all codes used in the Handbook.  The version of the code is not indicated (for 
example, MCNP, KENO etc). 
 
Library* 
 
The specific cross-section library(ies) used for the benchmark-model keff and keff uncertainty 
calculations.  This list includes all cross-section libraries currently employed by the codes 
used in the Handbook. 
 
Calculation label* 

 
Benchmark-model label, such as Simplified Model, Detailed Model, etc., as appropriate, or 
code name and version (for some configurations) is provided. 
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